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NOTICE
© 2000 Compaq Computer Corporation. Except for use in connection with the 
accompanying Compaq product, no part of this guide may be photocopied or reproduced 
in any form without prior written consent from Compaq Computer Corporation.

COMPAQ, the Compaq logo, and Armada are Registered in U.S. Patent and Trademark 
Office. iPAQ is a trademark of Compaq Information Technologies Group, L.P.

Microsoft, Windows, Windows NT, Windows 2000 Professional, Windows Millenium, 
and other names of Microsoft products referenced herein are trademarks or registered 
trademarks of Microsoft Corporation.

Intel and Pentium are registered trademarks of Intel Corporation. Celeron and MMX are 
trademarks of Intel Corporation.

All other product names mentioned herein may be trademarks or registered trademarks of 
their respective companies. 

Compaq shall not be liable for technical or editorial errors or omissions contained herein. 
The information in this document is subject to change without notice. 

THE INFORMATION IN THIS PUBLICATION IS PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND. THE ENTIRE RISK ARISING OUT OF THE USE OF 
THIS INFORMATION REMAINS WITH RECIPIENT. IN NO EVENT SHALL 
COMPAQ BE LIABLE FOR ANY DIRECT, CONSEQUENTIAL, INCIDENTAL, 
SPECIAL, PUNITIVE OR OTHER DAMAGES WHATSOEVER (INCLUDING 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION), EVEN IF 
COMPAQ HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND 
WHETHER IN AN ACTION OF CONTRACT OR TORT, INCLUDING NEGLIGENCE.

The limited warranties for Compaq products are exclusively set forth in the documentation 
accompanying such products. Nothing herein should be construed as constituting a further 
or additional warranty.

The following words and symbols mark special messages throughout this guide:

The following words and symbols mark special messages throughout this guide:

�
WARNING:  Text set off in this manner indicates that failure to follow directions could result in 
bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow directions could result in 
damage to equipment or loss of information.
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chapter 1
Troubleshooting

This guide provides information on how to identify and correct minor disk, 
graphics, memory, and software problems. It also explains many of the 
messages that may be displayed on the screen, including specific error 
messages that may appear during the Power-On Self-Test (POST) at startup.

POST Message Disabled suppresses most system messages during POST, 
such as memory count and non-error text messages. If a POST error occurs, 
the screen will display the error message. To manually switch to the POST 
Messages Enabled mode during POST, press any key (except F10 or F12). 
The default mode is POST Message Disabled.

The speed at which the Personal Computer loads the operating system and the 
extent to which it is tested are determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level 
tests, such as the memory test. Full Boot runs all of the ROM-based system 
tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly 
scheduled basis. To establish the schedule, reconfigure your Personal 
Computer to the Full Boot Every xx Days mode, using Computer Setup.

✎ For more information, refer to appendix B, “Computer Setup Utilities (F10 Setup)” on page 1.
Troubleshooting Guide 1-1
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Helpful Hints
If you encounter some minor problem with your Personal Computer, monitor, 
or software, refer to the following list of general suggestions before taking 
further action:

� Check that the Personal Computer and monitor are plugged into a working 
electrical outlet.

� Check to see that the Personal Computer is turned on and the power light is 
on.

� Check to see that the monitor is turned on and the monitor power light is 
on and not blinking.

� Turn up the brightness and contrast controls of the monitor if the monitor 
is dim. 

� Press and hold any key. If the system beeps, then your keyboard should be 
operating correctly.

� Check all cable connections for loose connections or incorrect 
connections.

� If you have installed an operating system other than the factory-installed 
operating system, check to be sure that it is supported on the Desktop 
Personal Computer. Windows 95 is not supported. To run Windows 98 or 
Windows NT 4.0, you must have the Legacy Module installed on the PC.

� Be sure that all the needed device drivers have been installed. For 
example, if you are using a printer, you need a printer driver.
1-2 Troubleshooting Guide
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Solving General Problems
You may be able to easily resolve the minor problems described in this 
section. If a problem persists and you are unable to resolve it yourself, contact 
Compaq Customer Support. 

Solving General Problems 
Problem Cause Solution

Computer won’t turn on. Computer is not connected to an 
external power source. 

Connect to an external power source.

Cables to the external power source are 
unplugged.

Ensure that cables connecting the Personal 
Computer to the external power source are 
plugged in properly and the wall outlet is active.

Computer appears locked up and won’t 
turn off when the power button is 
pressed.

Software control of the power switch is 
not functional.

Press and hold the power button until the Personal 
Computer turns off.

Computer date and time display is 
incorrect.

RTC (real-time clock) battery may need 
to be replaced. Battery life is 
approximately 3 years.

Reset the date and time under Control Panel. If the 
problem persists, contact Compaq Customer 
Support.

Computer powered off automatically. The unit temperature was exceeded. 
The fan may be blocked.

1 Unit is in an exceedingly hot environment. Let it 
cool down. 

2 Ensure Personal Computer air vents are not 
blocked and internal fan is running.

3 Contact Compaq Customer Support.

Computer appears to pause periodically Network driver is loaded and no 
network connection is established.

Establish a network connection, or use Computer 
Setup or Windows Device Manager to disable the 
network controller.

Cursor will not move using the arrow 
keys on the keypad.

The Num Lock key may be on. Press the Num Lock key. The Num Lock light 
should not be on if you want to use the arrow keys.

LS-120 drive light stays on. Diskette is damaged. In Windows 98 or Windows Millenium, run 
ScanDisk. Click 
Start > Programs > Accessories > System 
Tools > ScanDisk.

In Windows NT or Windows 2000, right click Start, 
click Explore, and select a drive. Select 
File > Properties > Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive is not properly connected. Reconnect drive.

LS-120 drive cannot write to a diskette. Diskette is not formatted. Format the diskette.
Troubleshooting Guide 1-3
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Diskette is write-protected. Use another diskette or remove the write 
protection.

Writing to the wrong drive Check the drive letter in your path statement.

Not enough space is left on the 
diskette.

Use another diskette.

Diskette write control is enabled. Use Computer Setup to check your storage 
security feature disabled settings.

A problem has occurred with a disk 
transaction. 

The directory structure is bad, or there 
is a problem with a file.

In Windows 98 or Windows Millenium, run 
ScanDisk. Click 

Start > Programs > Accessories > System 
Tools > ScanDisk.

In Windows NT or Windows 2000, right click Start, 
click Explore, and select a drive. Select 
File > Properties > Tools. Under Error-checking, 
click Check Now.

LS-120 drive cannot read a diskette. Diskette is not formatted. Format the diskette.

You are using the wrong diskette type 
for the drive type.

Check the type of drive you are using and use the 
correct diskette type.

Drive is not found or not recognized by 
the system.

Removable drive is not seated properly. Reseat the drive.

You attempted to hot plug a removable 
hard drive that has DriveLock security 
enabled.

Shut down Windows and turn off the Personal 
Computer. Insert the drive into the MultiBay, if it is 
not already inserted. (Refer to the the User’s for 
cautions and detailed instructions.) Turn on the 
Personal Computer.

Nonsystem disk message The system is trying to start from a 
nonsystem disk. 

Remove the diskette from the drive or replace it 
with a bootable disk.

Solving General Problems  (Continued)

Problem Cause Solution
1-4 Troubleshooting Guide
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Solving Graphics Problems
If you encounter graphics problems, refer to the documentation that came 
with your monitor and to the common causes and solutions listed in the 
following table.

Solving Graphics Problems 
Problem Cause Solution

Blank screen Monitor is not turned on and the 
monitor light is not on.

Turn on the monitor and check that the monitor 
light is on. 

The cable connections are not correct. Check the cable connection from the monitor to the 
Personal Computer and to the electrical outlet.

The energy saver feature has been 
enabled.

Press any key or click the mouse button and, if set, 
type your password.

The RGB (Red, Green, Blue) input 
switch on the monitor is incorrectly 
set.

Set the monitor’s RGB input switch to 75 ohms 
and, if there is a sync switch, set it to External.

You are using a fixed-sync monitor 
and it won’t sync at the resolution 
chosen.

Be sure that the monitor can accept the same 
sweep rate as the resolution chosen.

The VGA/BNC selector switch is not 
properly set.

Set the selector switch to agree with the cable 
connection.

Monitor does not function properly when 
used with energy saver features.

Monitor without energy saver 
capabilities is being used with energy 
saver features enabled.

Disable the monitor energy saver feature.

Graphics colors are wrong. The cabling or monitor impedance is 
incorrect.

1 If you are using BNC cables, be sure that the 
Red, Green, and Blue BNC cables are connected 
to the corresponding monitor connectors.

2 Be sure your monitor’s RGB inputs are set to 75 
ohms.

Dim characters The brightness and contrast controls 
are not set properly.

Adjust the monitor brightness and contrast 
controls.

The RGB switch on the back of the 
monitor is incorrectly set.

Set the RGB switch (and sync options, if this option 
is available) to 75 ohms, with the sync set to 
external. Refer to the documentation included with 
the monitor.

Screen goes blank. You may have a screen blanking utility 
installed or energy saver features are 
enabled.

Press any key or type a password. 
Troubleshooting Guide 1-5
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Solving Audio Problems

Solving Audio Problems 
Problem Cause Solution

Sound does not come out of the speaker 
or headphones.

The external speakers are not 
turned on.

Turn on the external speakers.

Software volume control is turned 
down.

Double click on the speaker icon on the taskbar, then 
set volume by adjusting the volume slider.

Sound does not come out of the internal 
speaker.

Headphones or devices connected 
to the line-out connector mute the 
internal speaker.

Turn on and use headphones or external speakers, if 
connected, or disconnect headphones or external 
speakers.
1-6 Troubleshooting Guide
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Solving Printer Problems
If you encounter printer problems, refer to the documentation that came with 
your printer and to the common causes and solutions listed in the following 
table.

Solving Printer Problems 
Problem Cause Solution

Printer will not print. Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for your 
application are not installed.

Install the correct printer drivers for your application. 

If you are on a network, you may not 
have made the connection to the 
printer.

Make the proper network connections to the printer.

Printer will not turn on. The cables may not be connected 
properly.

Reconnect all cables and check the power cord and 
electrical outlet.

Printer prints garbled information. The correct printer driver for your 
application is not installed.

Install the correct printer driver for your application.

The cables may not be connected 
properly.

Reconnect all cables.

Printer is offline. The printer may be out of paper. Check the paper tray and refill it if it is empty. Select 
online.
Troubleshooting Guide 1-7
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Solving Hardware Installation Problems
Refer also to the documentation that came with any optional hardware you 
have installed in the Personal Computer.

Solving Hardware Installation Problems 
Problem Cause Solution

A new device is not recognized as part of 
the system.

Device is not seated or connected 
properly. 

Ensure that the device is properly and securely 
connected and that pins in the connector are not bent 
down.

Power switch of new external 
device is not turned on.

Turn off the Personal Computer, turn on the external 
device, then turn on the Personal Computer to 
integrate the device with the Personal Computer 
system.
1-8 Troubleshooting Guide
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Solving Network Problems
Some common causes and solutions for network problems are listed in the 
following table. These guidelines do not discuss the process of debugging the 
network cabling.

Solving Network Problems 
Problem Cause Solution

Remote Wakeup feature is not 
functioning.

Remote Wakeup is not enabled. Use the Network control application to enable Remote 
Wakeup. Refer to the User’s Guide for more 
information on Desktop Management features.

Network driver does not detect network 
controller.

Network controller is disabled. Run Computer Setup and enable network controller.

Network status link light does not turn on 
or flashes.

No active network is detected. Check cabling and network equipment for proper 
connection.

Network controller is not set up 
properly.

Use the Network control application to verify that 
device is working properly. Refer to the User’s Guide 
for more information on using network 
communications.

Network driver is not properly 
loaded.

Reinstall network drivers. Refer to the User’s Guide for 
more information on using network communications.

System cannot autosense the 
network.

Disable autosensing capabilities and force the system 
into the correct operating mode. Refer to the User’s 
Guide for more information on using network 
communications.

Diagnostics reports a failure. The cable is not securely 
connected.

Ensure that the cable is securely attached to the 
network connector and that the other end of the cable 
is securely attached to the correct device.

The cable is attached to the 
incorrect connector.

Ensure that the cable is attached to the correct 
connector.

There is a problem with the cable or 
a device at the other end of the 
cable.

Ensure that the cable and device at the other end are 
operating correctly.

The network controller is defective. Contact Compaq Customer Support.

Diagnostics passes, but the Personal 
Computer does not communicate with 
the network.

Network drivers are not loaded, or 
driver parameters do not match 
current configuration.

Make sure the network drivers are loaded and that 
the driver parameters match the configuration of the 
network controller.

The network controller is not 
configured for this Personal 
Computer.

Select the Network icon at the Control Panel and 
configure the network controller.

Network controller stops working 
without apparent cause.

The files containing the network 
drivers are corrupted.

Reinstall the network drivers, using the Compaq 
Restore CD.
Troubleshooting Guide 1-9
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The cable is not securely 
connected.

Ensure that the cable is securely attached to the 
network connector and that the other end of the cable 
is securely attached to the correct device.

The network controller is defective. Contact Customer Support.

Cannot connect to network server when 
attempting Remote System Installation

The network controller is not 
configured properly.

Run Computer Setup (F10 Setup) and modify the NIC 
Settings.

Solving Network Problems  (Continued)

Problem Cause Solution
1-10 Troubleshooting Guide
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Solving Memory Problems
If you encounter memory problems, some common causes and solutions are 
listed in the following table.

Solving Memory Problems 
Problem Cause Solution

System won’t boot or does not function 
properly after installing additional 
memory modules.

Memory module is not the correct 
type or speed grade for the system 
or the new memory module is not 
seated properly.

Replace module with the correct industry-standard 
device for your Personal Computer.  

Out of Memory error Memory configuration may not be 
set up correctly.

Use the Device Manager to check memory 
configuration.

You have run out of memory to run 
the application.

Check the application documentation to determine the 
memory requirements.

Memory count during POST is wrong. The memory modules may not be 
installed correctly.

Check that the memory modules have been installed 
correctly and that proper modules are used. 

Insufficient memory error during 
operation

Too many Terminate and Stay 
Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need. 

You have run out of memory for your 
application.

Check the memory requirements for the application or 
add more memory to the Personal Computer.
Troubleshooting Guide 1-11
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Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, refer to the common causes 
and solutions listed in the following table or to the documentation that came 
with the optional device. 

Solving CD-ROM and DVD Problems 
Problem Cause Solution

System will not boot from CD-ROM or 
DVD drive.

The CD-ROM or DVD boot is not 
enabled through the Computer 
Setup utility.

Run the Computer Setup utility (F10 Setup) and set the 
drive priorities.

Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD devices are not detected 
or driver is not loaded.

Drive is not connected properly or 
not properly configured.

Refer to the documentation that came with the 
optional device.

Movie will not play in the DVD drive. Movie may be regionalized for a 
different country.

Refer to the documentation that came with the DVD 
drive.

Decoder software is not installed. Install decoder software.
1-12 Troubleshooting Guide
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Solving Software Problems
Most software problems occur as a result of the following:

� If you have installed an operating system other than the factory-installed 
operating system, check to be sure that it is supported on the iPAQ 
Desktop Personal Computer. Windows 95 is not supported. To run 
Windows 98 or Windows NT 4.0, you must have the Legacy Module 
installed on the PC.

� A software application was not installed or configured correctly.

� Be sure that all the needed device drivers have been installed. For 
example, if you are using a printer, you need a printer driver.

� There is insufficient memory available to run the application.

� There is a conflict between applications.

Where available, run the Compaq Configuration Utility to determine if any 
changes have been made to the software which may be causing a problem. 
Refer to the online Intelligent Manageability Guide for more information.
Troubleshooting Guide 1-13
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Troubleshooting Using Compaq Intelligent 
Manageability Features

The Local Alert Pop-Up Dialog notifies you of an impending or actual 
hardware failure. If the Personal Computer is connected to a network and the 
Compaq Management Agents are installed and configured, a message is sent 
to the specified management application. 

The Local Alert Pop-Up Dialog also tells you the steps you need to take prior 
to a hardware failure to avoid loss of data and damage to the Personal 
Computer. The system administrator can create a customized action message 
that might include contact telephone or pager numbers.

To close the Local Alert Pop-Up Dialog, click the Close button. To retrieve 
fault information after closing the dialog, run Computer Diagnostics.

For more detailed information, refer to the User’s Guide or to the online 
Intelligent Manageability Guide.
1-14 Troubleshooting Guide
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Compaq Configuration Record Utility
Compaq Configuration Record Utility is an online information-gathering tool 
similar to other Compaq management tools. It gathers critical hardware and 
software information from various sources to give a complete view of the 
Personal Computer. Configuration Record Utility provides a means for 
automatically identifying and comparing configuration changes, and has the 
ability to maintain a configuration history. The information can be saved as a 
history of multiple sessions.

This utility was developed to allow resolution of problems without taking the 
Personal Computer off-line and to assist in maximizing Personal Computer 
availability. The information obtained by the utility is useful in 
troubleshooting Personal Computer problems, and streamlines the service 
process by enabling quick and easy identification of Personal Computer 
configurations, which is the first step in resolving service cases.

The Compaq Configuration Record Utility is accessed via an icon in the 
Control Panel. When running the utility, information is automatically gathered 
on such items as the operating system version number, operating system 
parameters, and the operating system startup files. The utility then combines 
this information with information on the hardware configuration to deliver a 
comprehensive view of the Personal Computer.
Troubleshooting Guide 1-15
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Contacting Compaq Customer Support
For help and service, contact Compaq Customer Support. For a list of phone 
numbers, consult the warranty. 

✎ If you take your Personal Computer to a Compaq authorized service provider for service, 
remember to provide the setup and power-on passwords, if they are set.
1-16 Troubleshooting Guide
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appendix A
Resetting or Clearing CMOS

Resetting CMOS Using Computer Setup (F10)
The configuration memory (CMOS) stores system configuration information. 
It also stores the power-on and setup passwords, if set. 

To reset CMOS, you must first access the Computer Setup (F10 Setup) 
Utilities menu.

1. When the Computer Setup (F10 Setup) message appears in the 
lower-right corner of the screen, press the F10 key. Press Enter to bypass 
the title screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you must turn the Personal 
Computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup (F10 Setup) Utilities 
menu: File, Storage, Security, Power, and Advanced. 

2. To reset CMOS to the factory default settings use the arrow keys or the 
Tab key to select File > Set Defaults and Exit. 

Refer to appendix B, “Computer Setup Utilities (F10 Setup)” on page 1 for 
further instructions. 

If You Forget the Power-On or Setup Password

This computer supports security password features, which can be established 
through the Computer Setup Utilities menu.

This computer supports two security password features that are established 
through the Computer Setup (F10 Setup) Utilities menu: setup password and 
power-on password. When you establish only a setup password, any user can 
access all the information on the computer except Computer Setup (F10 
Setup). When you establish only a power-on password, the power-on 
Troubleshooting Guide A-1
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password is required to access Computer Setup (F10 Setup) and any other 
information on the computer. When you establish both passwords, only the 
setup password will give you access to Computer Setup (F10 Setup).

When both passwords are set, the setup password can also be used in place of 
the power-on password as an override to log into the computer. This is a 
useful feature for a network administrator.

If you forget the password for your computer, there are two methods for 
clearing that password so you may gain access to the information on the 
computer: 

� Resetting the password jumper

� Using the Clear CMOS button

Resetting the Password Jumper

�
WARNING:  To reduce the risk of personal injury from electrical shock and/or hot surfaces, be 
sure to disconnect the power cord from the wall outlet, and allow the internal system 
components to cool before touching.

CAUTION:  When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

CAUTION:  Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static 
electricity by briefly touching a grounded metal object. Refer to the Safety & Regulatory 
Information Guide for more information.

To disable the power-on or setup password features, or to clear the power-on 
or setup passwords without resetting CMOS, complete the following steps:

1. Exit all software applications, shut down the operating system software, 
turn off the Personal Computer and any external devices, then disconnect 
the power cord from the power outlet.
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2. Press down on the ribbed middle section at the top of the right access 
panel 1, then pivot and lift the access panel from the Personal Computer. 

Removing the Right Access Panel
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3. Remove the three screws 1 that secure the sheet metal 2 covering the 
system board.

Removing the Sheet Metal Covering the System Board

4. Locate the password jumper. The header is labeled E49. 

5. Remove the jumper from pins 1 and 2. Place the jumper over pin 2 only, 
in order to avoid losing it.

6. Replace the access panel, making sure that it is aligned on the two tabs on 
the base of the Personal Computer 2, then pivot it up and toward the 
Personal Computer until it locks into place.

7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to 
start. This clears the current passwords and disables the password 
features.
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To re-enable the password features, repeat steps 1–4, then replace the jumper 
on pins 1 and 2. Repeat steps 6–8, then establish new passwords. Refer to 
appendix B, “Computer Setup Utilities (F10 Setup)” on page 1 for 
instructions.

Using the Clear CMOS Button

The computer’s configuration memory (CMOS) stores password information 
as well information about the computer’s configuration.

CAUTION:  Pushing the CMOS button will reset CMOS values to factory defaults and will erase 
any customized information including passwords, asset numbers, and special settings.

�
WARNING:  To reduce the risk of personal injury from electrical shock and/or hot surfaces, be 
sure to disconnect the power cord from the wall outlet, and allow the internal system 
components to cool before touching.

CAUTION:  When the computer is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in 
damage to the system.

CAUTION:  Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static 
electricity by briefly touching a grounded metal object. Refer to the Safety & Regulatory 
Information Guide for more information.

To disable the power-on or setup password features, or to clear the power-on 
or setup passwords, complete the following steps:

1. Exit all software applications, shut down the operating system software, 
turn off the Personal Computer and any external devices, then disconnect 
the power cord from the power outlet.

2. Press down on the ribbed middle section at the top of the right access 
panel 1, then pivot and lift the access panel from the Personal Computer. 
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3. Locate the CMOS button opening (above and slightly to the left of the 
memory module).

4. Insert the eraser end of a pencil into the opening to press the CMOS 
button (shown in the illustration below) and hold it in for 5 seconds. 

5. Replace the access panel, making sure that it is aligned on the two tabs on 
the base of the Personal Computer 2, then pivot it up and toward the 
Personal Computer until it locks into place.

6. Reconnect the external equipment.

7. Plug in the computer and turn on power. Allow the operating system to 
start. This clears the current passwords and disables the password 
features.

✎ You will need to reset your passwords and any special system setups along with the date and 
time. Refer to the "Using Computer Setup" section for further instructions
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appendix B
Computer Setup Utilities (F10 Setup)

Use Computer Setup to do the following:

� Change factory default settings.

� Set the system date and time.

� Set, view, change, or verify the system configuration, including settings 
for processor, graphics, memory, audio, storage, communications, and 
input devices.

� Modify the boot order of bootable devices such as hard drives, diskette 
drives, CD-ROM drives, DVD-ROM drives, or LS-120 drives.

� Enable Quick Boot, which is faster than Full Boot but does not run all of 
the diagnostic tests run during a Full Boot. You can set your system to:

❏ always Quick Boot (default);

❏ periodically Full Boot (from every 1 to 30 days); or

❏ always Full Boot.
� Enable or disable Network Server Mode, which allows the Personal 

Computer to boot the operating system when the power-on password is 
enabled, with or without a keyboard or mouse attached. When attached to 
the system, the keyboard and mouse remain locked until the power-on 
password is entered.

� Select Post Messages Enabled or Disabled to change the display status of 
Power-On Self-Test (POST) messages. Post Messages Disabled 
suppresses most POST messages, such as memory count, product name, 
and other non-error text messages. If a POST error occurs, the error is 
displayed regardless of the mode selected. To manually switch to Post 
Messages Enabled during POST, press any key (except F10 or F12).

� Establish an Ownership Tag, the text of which is displayed each time the 
system is turned on or restarted.

� Enter the Asset Tag or property identification number assigned by your 
company to this Personal Computer.
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� Enable power-on password prompting during system restarts (warm boots) 
as well as during power-on.

� Establish a setup password that controls access to Computer Setup (F10) 
and the settings described in this section.

� Secure serial, USB, or parallel ports so that they cannot be used until they 
are unsecured.

� Enable or disable removable media boot ability.

� Enable or disable removable media write ability.

� Enable or disable DriveLock security for MultiBay drives.

� Solve system configuration errors detected but not automatically fixed 
during the Power-On Self-Test (POST).

� Execute self-tests on a specified IDE hard drive.

� Configure various energy-saving features including energy saver mode, 
system and hard drive timeouts, power button mode, power LED behavior, 
and fan speed selection.

Using Computer Setup Utilities

To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the Personal Computer. If you are in Windows, click 
Start  > Shut Down > Restart the Computer.

2. When the F10=Setup message appears in the lower-right corner of the 
screen, press the F10 key.

✎ If you do not press the F10 key while the message is displayed, you must turn the Personal 
Computer off, then on again, to access the utility.

3. Select your language from the list and press the Enter key.

A choice of five headings appears in the Computer Setup Utilities menu: 
File, Storage, Security, Power, and Advanced.

4. Using the arrow keys or the Tab key, select the option you want and press 
the Enter key. To return to the Computer Setup Utilities menu, press the 
Esc key.

5. To apply and save changes, select File > Save Changes and Exit.
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❏ If you selected an option that automatically restarted the Personal 
Computer, changes were applied at that time.

❏ If you have made changes that you do not want applied, select Ignore 
Changes and Exit.

❏ If you have already applied changes you now want to eliminate, select 
Set Defaults and Exit. This option will restore the original factory 
system defaults.

Computer Setup 
Heading Option Description

File System Information Lists:

� product name

� processor type/speed/stepping

� cache size (L1/L2)

� installed memory size 

� integrated MAC for embedded, enabled NIC (if applicable)

� system ROM (includes family name and version)

� system board revision 

� chassis serial number

� asset tracking number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Save to Diskette Saves system configuration, including CMOS, to a blank, 
formatted 1.44-MB diskette.

Restore from Diskette Restores system configuration, including CMOS, from a diskette.

Set Defaults and Exit Restores factory default settings, which includes clearing any 
established passwords. 

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration and exits Computer 
Setup.

Storage Device Configuration Lists all installed storage devices. The following options appear 
when a device is selected: 

Diskette Type

Identifies the highest capacity media type accepted by the 
MultiBay SuperDisk drive. Options are: LS-120; LS-260

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Storage
(continued)

Device Configuration
(continued)

Drive Emulation (IDE devices only)

Allows you to select a drive emulation type for a storage device. 
(For example, a Zip drive can be made bootable by selecting 
disk emulation.) 

Drive Type Emulation Options

Hard disk No emulation options available.

Diskette None (treated as diskette drive)

Disk (treated as hard drive)

CD-ROM None (treated as CD-ROM drive)

Diskette (treated as diskette drive)

Disk (treated as hard drive)

Other (e.g., Zip drive) None (treated as Other)

CD-ROM (treated as CD-ROM drive)

Diskette (treated as diskette drive)

Disk (treated as hard drive)

Transfer Mode (IDE devices only)

Specifies the active data transfer mode.  Options (subject to 
device capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra 
DMA 0, and Max UDMA.

Translation Mode (IDE disks only)

Lets you select the translation mode to be used for the device. 
This enables the BIOS to access disks partitioned and formatted 
on other systems and may be necessary for users of older 
versions of Unix (e.g., SCO Unix version 3.2). Options are 
Bit-Shift, LBA Assisted, User, and None.

CAUTION:  Ordinarily, the translation mode selected 
automatically by the BIOS should not be changed. If the selected 
translation mode is not compatible with the translation mode 
that was active when the disk was partitioned and formatted, 
the data on the disk will be inaccessible.

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Storage
(continued)

Device Configuration
(continued)

Translation Parameters (IDE Disks only)

Allows you to specify the parameters (logical cylinders, heads, 
and sectors per track) used by the BIOS to translate disk I/O 
requests (from the operating system or an application) into 
terms the hard drive can accept. Logical cylinders may not 
exceed 1024. The number of heads may not exceed 256. The 
number of sectors per track may not exceed 63. These fields are 
only visible and changeable when the drive translation mode is 
set to User.

Multisector Transfers (IDE ATA devices only)

Specifies how many sectors are transferred per multi-sector PIO 
operation.  Options (subject to device capabilities) are Disabled, 
8, and 16. 

Quiet Drive (available on select drives only)

� Performance
Allows the drive to operate at maximum performance.

� Quiet
Reduces noise from the drive during operation. When set to 
Quiet, the drive will not operate at maximum performance.

If the drive does not support Quiet mode, the Quiet Drive option 
will not be displayed. 

Storage Options Removable Media Boot

Enables/disables ability to boot the system from removable 
media.

Note: After saving changes to Removable Media Boot, the 
computer will restart. Turn the computer off, then on, manually.

Removable Media Write

Enables/disables ability to write data to removable media.

Note: This feature applies only to legacy diskette, IDE MultiBay 
Superdisk LS-120 and LS260 drives.

Primary IDE Controller

Allows you to enable or disable the primary IDE controller. 

Secondary IDE Controller

Allows you to enable or disable the secondary IDE controller. 

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Storage
(continued)

Storage Options
(continued)

Diskette MBR Validation

Allows you to enable or disable strict validation of the diskette 
Master Boot Record (MBR).  

Note: If you use a bootable diskette image that you know to be 
valid, and it does not boot with Diskette MBR Validation enabled, 
you may need to disable this option in order to use the diskette.

DPS Self-Test Allows you to execute self-tests on IDE hard drives capable of 
performing the Drive Protection System (DPS) self-tests.

Note: This selection will only appear when at least one drive 
capable of performing the IDE DPS self-tests is attached to the 
system.

Boot Order Allows you to specify the order in which attached peripheral 
devices (such as diskette drive, hard drive, CD-ROM, or network 
interface card) are checked for a bootable operating system 
image. Each device on the list may be individually excluded from 
or included for consideration as a bootable operating system 
source. For systems with more than one attached diskette or 
disk drive, a submenu allows you to specify the order in which 
the devices are assigned drive letters.

Note: MS-DOS drive lettering assignments may not apply after a 
non-MS-DOS operating system has started.

To boot one time from a device other than the default device 
specified in Boot Order, restart the computer and press F9 when 
the F10=Setup message appears on the screen. When POST is 
completed, a list of bootable devices is displayed. Use the arrow 
keys to select a device and press the Enter key.

Security Setup Password Allows you to set and enable setup (administrator) password. 

Note: If the setup password is set, it is required to change 
Computer Setup options, flash the ROM, and make changes to 
certain plug and play settings under Windows. Also, this 
password must be set in order to use some Compaq remote 
security tools.

Power-On Password Allows you to set and enable power-on password.

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Security
(continued)

Password Options Allows you to:

� enable/disable network server mode. 

Note: This selection will appear only if a power-on password is 
set. 

� specify whether password is required for warm boot 
(CTRL+ALT+DEL). 

Note: This selection is available only when Network Server 
Mode is disabled. 

See the the “Desktop Management” section of the User’s Guide 
for more information. 

DriveLock Security Allows a MultiBay hard drive to be locked, preventing 
unauthorized access to data stored on the drive.

Device Security Enables/disables serial, parallel, audio, and NIC security.

Network Service Boot Enables/disables the computer's ability to boot from an 
operating system installed on a network server. (Feature 
available on NIC models only; the network controller must reside 
on the PCI bus or be embedded on the system board.)

System IDs Allows you to set:

� asset tag (16-byte identifier) and ownership Tag (80-byte 
identifier displayed during POST)

See the the “Desktop Management” section of the User’s Guide 
for more information. 

� chassis serial number or Universal Unique Identifier (UUID) 
number if current number is invalid (these ID numbers are 
normally set in the factory and are used to uniquely identify 
the system)

� keyboard locale setting (e.g., English or German) for System 
ID entry

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Security
(continued)

Master Boot Record Security Allows you to enable or disable Master Boot Record (MBR) 
Security. When enabled, the BIOS rejects all requests to write to 
the MBR on the current bootable disk. Each time the computer is 
powered on or rebooted, the BIOS compares the MBR of the 
current bootable disk to the previously-saved MBR. If changes 
are detected, you are given the option of saving the MBR on the 
current bootable disk, restoring the previously-saved MBR, or 
disabling MBR Security. You must know the setup password, if 
one is set.

Note: Disable MBR Security before intentionally changing the 
formatting or partitioning of the current bootable disk. Several 
disk utilities (such as FDISK and FORMAT) attempt to update the 
MBR. If MBR Security is enabled and disk accesses are being 
serviced by the BIOS, write requests to the MBR are rejected, 
causing the utilities to report errors. If MBR Security is enabled 
and disk accesses are being serviced by the operating system, 
any MBR change will be detected by the BIOS during the next 
reboot, and an MBR Security warning message will be 
displayed.

Save Master Boot Record Saves a backup copy of the Master Boot Record of the current 
bootable disk.

Note: Only appears if MBR Security is enabled.

Restore Master Boot Record Restores the backup Master Boot Record to the current bootable 
disk.

Note: Only appears if all of the following conditions are true:

� MBR Security is enabled.

� A backup copy of the MBR has been previously saved.

� The current bootable disk is the same disk from which the 
backup copy of the MBR was saved.

Power Energy Saver Allows you to set the energy saver mode (advanced, disable, or 
minimal).

Note: In the minimal energy saver mode setting, the hard drive 
and system do not go into energy saver mode, but the setting 
allows you to press the power button to suspend the system.

This option is not available under ACPI-enabled operating 
systems.

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Power
(continued)

Timeouts Allows you to disable or manually select timeout values for the 
system and/or all attached IDE hard drives. 

Note: This option is not available under ACPI-enabled operating 
systems. This selection will only appear when energy saver 
mode is set to advanced.

Energy Saver Options Allows you to set: 

� power button configuration (on/off or sleep/wake) under 
APM-enabled operating systems

� power LED blink in suspend (or standby) mode 
(enable/disable). This option is not available under 
ACPI-enabled operating systems.

Note:  Energy Saver Options will not appear if the energy saver 
mode is disabled.

Advanced Power-On Options Allows you to set:

� POST mode (QuickBoot, FullBoot, or FullBoot every 1-30 
days)

� POST messages (enable/disable)

� Safe POST (enable/disable)

� F9 prompt (enable/disable)

� F10 prompt (enable/disable)

� F12 prompt (enable/disable)

� Option ROM prompt (enable/disable)

� Remote wakeup boot sequence (remote server/local hard 
drive)

� After power loss (off/on)  

If you connect your computer to an electric power strip, and 
would like to turn on power to the computer using the switch on 
the power strip, set this option to on.

Note: If you turn off power to your computer using the switch on 
a power strip, you will not be able to use the suspend/sleep 
feature or the Remote Management features.

� UUID (Universal Unique Identifier) (enable/disable)

� POST delay (enable/disable)

� I/O APIC mode (enable/disable)

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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Advanced
(continued)

Onboard Devices
Only visible when Legacy Module is 
installed

Allows you to set resources for or disable onboard system 
devices (diskette controller, serial port, parallel port).

Device Options Allows you to set:

� Printer mode (bi-directional, EPP & ECP, output only) 
(Parallel printers connected to Legacy Module only)

� Num Lock state at power-on (off/on)

� PME (power management event) wakeup events 
(enable/disable)

� Processor cache (enable/disable)

� Processor Number (enable/disable) for Pentium III 
processors.

� ACPI S3 support (enable/disable). S3 is an ACPI (advanced 
configuration and power interface) sleep state that some 
add-in hardware options may not support.

� AGP Aperture size (options vary depending on platform) 
allows you to modify the size of your AGP aperture size 
window.

Computer Setup  (Continued)

Heading Option Description

Support for Computer Setup options may vary depending on your specific hardware configuration.
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appendix C
Compaq Diagnostics for Windows

Compaq Diagnostics for Windows is a component of Intelligent 
Manageability that allows you to view:

� System overview

� AssetControl information

� Input devices

� Communications ports

� Storage devices

� Graphics information

� Memory configuration

� Security management settings

� System health

� Operating system

� Windows version

Depending on the version, Compaq Diagnostics for Windows may include 
diagnostic tests to determine if all the devices installed on the Personal 
Computer are recognized by the system and are functioning properly. 
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Using Compaq Diagnostics for Windows
1. Select the Compaq Diagnostics icon, located in the Control Panel.

The screen displays an overview of the Personal Computer hardware and 
software.

2. For specific hardware and software information, select a category from 
the Categories menu or from the toolbar.

✎ As you move your cursor over the toolbar icons, the corresponding category names appear near 
the cursor.

3. To display more detailed information in a selected category, click More in 
the Information Level box.

4. Review and print this information and, if necessary, discuss it with your 
Compaq authorized service provider.

✎ To print the information, click File, then select Print. Select one of the following options: Detailed 
Report (All Categories), Summary Report (All Categories), or Current Category. Click OK to print 
the report you selected.

5. To exit Compaq Diagnostics for Windows, click File, then click Exit.

Running Diagnostic Tests

If your version of Compaq Diagnostics for Windows includes diagnostic 
testing utilities, four tabs will appear next to Overview—Test, Status, Log, 
and Error.

1. Select the Test tab. 

2. Select one of the following options:

❏ Quick Test-Runs a quick, general test on each device with a minimal 
number of prompts.

❏ Complete Test-Runs maximum testing of each device with minimal 
prompts.

❏ Custom Test-Runs only the tests you select. To select specific devices 
or tests, find the device in the list, then click the box beside each test 
to select or deselect it. When selected, a red check mark appears in 
the box.
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3. Select Interactive Mode or Unattended Mode. 

In Interactive Mode, the diagnostic software will prompt you for input 
during tests that require it. Some tests require interaction and will display 
errors or halt testing if selected in conjunction with Unattended Mode. 

4. Click the Begin Testing button.

Test Status is displayed, showing the progress and result of each test. 

5. If errors are found, click the Error tab to display more detailed 
information and recommended actions. By following the recommended 
actions, you may be able to solve some problems yourself.

6. Click Print or Save the error information in case you need to contact your 
Compaq authorized service provider for assistance.

7. To exit Compaq Diagnostics for Windows, click File, then click Exit.
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appendix D
POST Error Messages

Error Codes
This chapter lists the error codes that you may encounter during the Power-On 
Self-Test (POST) that occurs when the Personal Computer is restarted, the 
probable source of the problem, and what steps you can take to resolve the 
error condition.

Power-On Self-Test Messages 
Message Beeps Probable Cause Recommended Action

101-Option ROM Error 1L, 1S System ROM checksum 1 Verify the correct ROM

2 Flash the ROM if needed.

3 If the problem persists, contact Compaq Customer 
Support.

102-System Board Failure None DMA, timers, and so forth 1 Follow directions in Appendix A to clear CMOS.

2 If the problem persists, contact Compaq Customer 
Support.

103-System Board Failure None DMA, timers, and so forth 1 Follow directions in Appendix A to clear CMOS.

2 If the problem persists, contact Compaq Customer 
Support.

162-System Options Not Set 2S Configuration incorrect RTC (real-time clock) battery may need to be 
replaced. Battery life is approximately 5 years.

1 Run Computer Setup (F10 Setup).

2 Reset the date and time under Control Panel. If the 
problem persists, contact Compaq Customer 
Support.

163-Time & Date Not Set 2S Invalid time or date in 
configuration memory

RTC (real-time clock) battery may need to be 
replaced. Battery life is approximately 5 years.

1 Run Computer Setup (F10 Setup).

2 Reset the date and time under Control Panel. If the 
problem persists, contact Compaq Customer 
Support.

* L = Long, S = Short
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164-Memory Size Error 2S Memory configuration incorrect 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Make sure your memory module(s) are installed 
properly.

3 Verify proper memory module type.

201-Memory Error None RAM failure 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Ensure memory and continuity modules are 
installed correctly.

3 Verify proper memory module type.

4 Remove and replace the memory module(s) one 
at a time to isolate faulty module.

5 Replace faulty memory module(s).

6 If error persists after replacing memory modules, 
contact Compaq Customer Support.

202-Memory Type Mismatch None Memory modules do not match 
each other.

Replace memory modules with matched sets.

207-ECC Corrected Single Bit 
Errors in DIMM/SIMM Pair(s) 
x,x in Memory Module 
Socket(s) y,y,…

2S Single Bit ECC error 1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory module if problem persists.

301-Keyboard Error None Keyboard failure 1 Reconnect keyboard with Personal Computer 
turned off.

2 Check connector for bent or missing pins.

3 Ensure that none of the keys are depressed.

4 Replace keyboard.

213-Incompatible DIMM 
Module in DIMM Socket(s) X, 
X, …

2S A DIMM module in DIMM socket 
identified in the error message is 
missing critical SPD information, 
or is incompatible with the 
chipset.

1 Verify proper memory module type.

2 Try another memory socket.

3 Replace DIMM with a module conforming to the 
SPD standard.

304-Keyboard or System Unit 
Error

None Keyboard failure 1 Reconnect keyboard with Personal Computer 
turned off.

2 Check connector for bent or missing pins.

3 Ensure that none of the keys are depressed.

4 Replace keyboard.

5 If the problem persists, contact Compaq Customer 
Support.

Power-On Self-Test Messages  (Continued)

Message Beeps Probable Cause Recommended Action

* L = Long, S = Short
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410-Audio Interrupt Conflict 2S IRQ address conflicts with another 
device.

Reset the IRQ.

501-Display Adapter Failure 1L, 2S Graphics display controller 1 Follow directions in Appendix A to clear CMOS.

2 Verify monitor is attached and turned on

660-Display cache is detected 
unreliable

None Integrated graphics controller 
display cache not working 
properly and will be disabled.

Contact Compaq Customer Support if minimal 
graphics degrading is an issue.

1720-SMART Hard Drive 
Detects Imminent Failure

None Hard drive is about to fail. (Some 
hard drives have a firmware patch 
that will fix an erroneous error 
message).

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
available.

2 Apply firmware patch if applicable.

3 Back up contents and replace hard drive.

1721-SMART SCSI Hard Drive 
Detects Imminent Failure

None Hard drive is about to fail. (Some 
hard drives have a firmware patch 
that will fix an erroneous error 
message).

1 Determine if hard drive is giving correct error 
message.

2 Apply firmware patch if applicable.

3 Back up contents and replace hard drive.

1780-Disk 0 Failure None Hard drive/format error 1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cables/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

Power-On Self-Test Messages  (Continued)

Message Beeps Probable Cause Recommended Action

* L = Long, S = Short
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1781-Disk 1 Failure None Hard drive/format error 1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cables/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

1782-Disk Controller Failure None Hard drive circuitry error 1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

8 If the problem persists, contact Compaq Customer 
Support.

1790-Disk 0 Error None Hard drive error or wrong drive 
type

1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cable seating jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Confirm drive is supported on this Personal 
Computer (large drive ROM support).

7 Run the Drive Protection System test if available.

8 Replace the hard drive.

9 If the problem persists, contact Compaq Customer 
Support.

Power-On Self-Test Messages  (Continued)

Message Beeps Probable Cause Recommended Action

* L = Long, S = Short
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1791-Disk 1 Error None Hard drive error or wrong drive 
type

1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Confirm drive is supported on this computer (large 
drive ROM support).

7 Run the Drive Protection System test if available.

8 Replace the hard drive.

9 If the problem persists, contact Compaq Customer 
Support.

1792-Secondary Disk 
Controller Failure

None Hard drive circuitry error 1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

1793-Secondary Controller or 
Disk Failure

None Hard drive circuitry error 1 Run Computer Setup (F10 Setup).

2 Follow directions in Appendix A to clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

1800-Temperature Alert None Internal temperature exceeds 
specification.

1 Check that Personal Computer air vents are not 
blocked and cooling fan is running.

2 Verify processor speed selection.

3 If the problem persists, contact Compaq Customer 
Support.

1801 None Processor is not supported by 
ROM BIOS.

Upgrade BIOS to proper version.

Power-On Self-Test Messages  (Continued)

Message Beeps Probable Cause Recommended Action

* L = Long, S = Short
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Audible 2S Power-on successful None

NOTE: If you have a Universal Serial Bus (USB) keyboard, you will hear the beep sequences for the following error codes, but you will not 
see the flashing keyboard lights.

Flashing Caps Lock LED on 
Keyboard

1L, 2S Graphics controller not present or 
incorrectly initialized

Follow directions in Appendix A to clear CMOS.

Flashing Num Lock LED on 
Keyboard

1S, 2L System memory not present 1 Check memory module (refer to the relevant 
section of the User’s Guide).

2 Remove and reseat memory module.

3 See the "Solving Memory Problems" section of 
this guide.

Flashing Scroll Lock LED on 
keyboard

2L, 1S System board hardware failure 
(prior to graphics)

If the problem persists, contact Compaq Customer 
Support.

Green Power LED Blinks 1x / 
Second.

None Personal Computer in normal 
Suspend mode

None

Green Power LED On None Computer on None

Invalid Electronic Serial 
Number

None Electronic serial number has 
become corrupted.

Run Computer Setup. If Setup already has data in the 
field or will not allow the serial number to be entered, 
download from www.compaq.com and run 
SP5572.EXE (SNZERO.EXE).

Power-On Self-Test Messages  (Continued)

Message Beeps Probable Cause Recommended Action

* L = Long, S = Short
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appendix E
Drive Protection System (DPS)

Introducing the Drive Protection System
The Compaq Drive Protection System (DPS) is a diagnostic tool built into the 
hard drives installed in select Compaq iPAQ Desktop Personal Computers. 
DPS is designed to help diagnose problems that might result in unwarranted 
hard drive replacement.

Each installed hard drive is tested using DPS and a permanent record of key 
information is written onto the drive. Each time DPS is run, test results are 
written to the hard drive. Your service provider can use this information to 
help diagnose conditions that caused you to run the DPS software. 

Running DPS will not affect any programs or data stored on the hard drive. 
The test resides in the hard drive firmware and can be executed even if the 
Personal Computer will not boot to an operating system. The time required to 
execute the test depends on the manufacturer and size of the hard drive; in 
most cases, the test will take approximately two minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the Personal Computer 
reports a SMART Hard Drive Detect Imminent Failure message, there is no 
need to run DPS; instead, back up the information on the hard drive and 
contact your Compaq service provider for a replacement hard drive.

Accessing DPS Through Computer Setup

When the Personal Computer does not power-on properly you should use 
Computer Setup (F10 Setup) to access the DPS program. To access DPS, 
perform the following steps:

1. Turn on or restart the Personal Computer.

2. When the F10 Setup message appears in the lower-right corner of the 
screen, press the F10 key. 

If you do not press the F10 key while the message is displayed, you must 
turn the Personal Computer off, then on again, to access the utility.
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A choice of five headings appears in the Computer Setup Utilities menu: 
File, Storage, Security, Power, and Advanced.

3. Select Storage > IDE DPS Self-Test.

The screen will display the list of DPS-capable hard drives that are 
installed on the Personal Computer.

✎ If no DPS capable hard drives are installed, the IDE DPS Self-Test option will not appear on the 
screen.

4. Select the hard drive to be tested and follow the screen prompts to 
complete the testing process.

When the test has been completed, one of three messages will be displayed:

� Test Succeeded. Completion Code 0. 

� Test Aborted. Completion Code 1 or 2.

� Test Failed. Drive Replacement Recommended. Completion Code 3 
through 14.

If the test failed, the completion code should be recorded and reported to your 
service provider for help in diagnosing the problem.

Accessing DPS Through Compaq Diagnostics for Windows

To access DPS through Compaq Diagnostics for Windows, perform the 
following steps:

1. Turn on the Personal Computer and select My Computer >Control Panel 
> Compaq Diagnostics.

A choice of five possible headings appears in the Diagnostics screen: 
Overview, Test, Status, Log, and Error.

2. Select Test > Type of Test

A choice of three tests appear: Quick Test, Complete Test, and Custom 
Test.

3. Select Custom Test.
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A choice of two test modes is offered: Interactive Mode and Unattended 
Mode.

4. Select Interactive Test > Storage > Hard Drives.

5. Select the specific drives to be tested > Drive Protection System Test > 
Begin Testing.

When the test has been completed, one of three messages will be displayed for 
each of the drives tested:

� Test Succeeded. Completion Code 0. 

� Test Aborted. Completion Code 1 or 2.

� Test Failed. Drive Replacement Recommended. Completion Code 3 
through 14.

If the test failed, the completion code should be recorded and reported to your 
service provider for help in diagnosing the problem.
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appendix F
Electrostatic Discharge

A discharge of static electricity from a finger or other conductor may damage 
system boards or other static-sensitive devices. This type of damage may 
reduce the life expectancy of the device. 

Preventing Electrostatic Damage
To prevent electrostatic damage, observe the following precautions:

� Avoid hand contact by transporting and storing products in static-safe 
containers.

� Keep electrostatic-sensitive parts in their containers until they arrive at 
static-free workstations.

� Place parts on a grounded surface before removing them from their 
containers.

� Avoid touching pins, leads, or circuitry.

� Always be properly grounded when touching a static-sensitive component 
or assembly.

Grounding Methods

There are several methods for grounding. Use one or more of the following 
methods when handling or installing electrostatic-sensitive parts:

� Use a wrist strap connected by a ground cord to a grounded workstation or 
personal computer chassis. Wrist straps are flexible straps with a minimum 
of 1 Mohm +/- 10 percent resistance in the ground cords. To provide 
proper ground, wear the strap snug against the skin.

� Use heelstraps, toestraps, or bootstraps at standing workstations. Wear the 
straps on both feet when standing on conductive floors or dissipating floor 
mats.

� Use conductive field service tools.

� Use a portable field service kit with a folding static-dissipating work mat.
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If you do not have any of the suggested equipment for proper grounding, 
contact your Compaq authorized service provider.

✎ For more information on static electricity, contact your Compaq authorized service provider.
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appendix G
Routine Care & Shipping Information

Routine Care
Follow these suggestions to take care of your personal computer and monitor:

� Operate the personal computer on a sturdy, level surface. Leave a 3-inch 
(7.6-cm) clearance at the back of the system unit and above the monitor to 
permit the required airflow.

� Never operate the personal computer with the cover or side panel 
removed.

� Never restrict the airflow into the personal computer by blocking the air 
intake or exhaust vents. 

� Keep the personal computer away from excessive moisture, direct 
sunlight, and extremes of heat and cold. For information about the 
recommended temperature and humidity ranges for your personal 
computer, refer to the Specifications in the User’s Guide.

� Keep liquids away from the personal computer and keyboard.

� Never cover the ventilation slots on the monitor with any type of material.

� Turn off the personal computer before you do either of the following:

❏ Wipe the exterior of the personal computer with a soft, damp cloth as 
needed. Using cleaning products may discolor or damage the finish.

❏ Occasionally clean the air intake and exhaust vents on the personal 
computer. Lint and other foreign matter can block the vents and limit 
the airflow.
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CD-ROM Drive Precautions
Be sure to observe the following guidelines while operating or cleaning your 
CD-ROM drive.

Operation

� Do not move the drive during operation. This may cause it to malfunction 
during reading.

� Avoid exposing the drive to sudden changes in temperature, as 
condensation may form inside the unit. If the temperature suddenly 
changes while the drive is on, wait at least one hour before you turn off the 
power. If you operate the unit immediately, it may malfunction while 
reading.

� Avoid placing the drive in a location that is subject to high humidity, 
extreme temperatures, mechanical vibration, or direct sunlight.

Cleaning

� Clean the panel and controls with a soft, dry cloth or a soft cloth lightly 
moistened with a mild detergent solution. Never spray cleaning fluids 
directly on the unit.

� Avoid using any type of solvent, such as alcohol or benzene, which may 
damage the finish.

Safety

If any object or liquid falls into the drive, immediately unplug the personal 
computer and have it checked by an authorized Compaq service provider.

Shipping Preparation

Follow these suggestions when preparing to ship your personal computer:

1. Back up the hard drive files onto the network or removable media. Be 
sure that the backup media is not exposed to electrical or magnetic 
impulses while stored or in transit.

✎ The hard drive locks automatically when the system power is turned off.

2. Remove and store separately any removable media and MultiBay drives.
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3. Turn off the personal computer and external devices.

4. Disconnect the power cord from the electrical outlet, then from the 
personal computer.

5. Disconnect the system components and external devices from their power 
sources, then from the personal computer.

6. Pack the system components, MultiBay drives, and external devices in 
their original packing boxes or similar packaging with sufficient packing 
material to protect them.

✎ For environmental nonoperating ranges, refer to the Specifications in the User’s Guide.
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